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1. About this Manual

This manual provides the information necessary to help customers operate Bartsoft software 
from Bartington Instruments.

Bartsoft runs on a Windows-compatible PC, referred to as the host PC. It is provided free of 
charge with the Bartington Instruments MS3 meter and is designed for operation with any of the 
sensors from the Bartington MS2 range. It can also be used with the Bartington Instruments 
MS2 meter via an RS-232 connection to the host PC. Multiple MS2/MS3 devices can be connected 
simultaneously to the host PC running the application.

Bartsoft is available for download from the Bartington Instruments website at www.bartington.
com/software.html. 

For operation of the MS2 devices, see OM0408 MS2 Magnetic Susceptibility System, available on 
the MS2/MS3 product page of the Bartington Instruments website at www.bartington.com/ms3.
html.

1.1. Symbols Glossary

The following symbols used within this manual call your attention to specific types of 
information:

Note: Provides useful supporting information on how to make better use of your purchase.

1.2. Running Windows-based Applications

Names of Windows-based applications and menu / command options are shown in bold type.

Sequences of instructions for running Windows- and Windows-based applications are shown 
with an arrow: →.

Hence, for example, Control Panel → System and Security → Device Manager means ‘in 
Windows, click on Control Panel, then System and Security, then Device Manager’.

Note: The user’s familiarity with different versions of the Windows operating system is 
assumed. Hence, for example, an instruction might be to ‘open Control Panel’ rather than 
a detailed description of the route to follow to get to Control Panel, as these steps will not 
necessarily be the same from one version of Windows to the next.

http://www.bartington.com/software.html
http://www.bartington.com/software.html
http://www.bartington.com/ms3.html
http://www.bartington.com/ms3.html
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2. Introduction

Bartsoft software acquires, corrects, displays, stores and prints data using Bartington 
Instruments MS2 and MS3 meters. This guide explains how to use the software and helps the 
user understand how it works, including the function of all controls and windows.

3. Installation

3.1. Introduction

This section describes the installation process of the Bartsoft software and the USB drivers for 
the MS3 meter. 

Bartsoft is available for download from the Bartington Instruments website. The zipped files on 
the website contain the latest version of the application installer and the software, for both 32- 
and 64-bit versions of Windows XP, Windows 7 and Windows 8.

Note: Downloading from the website will ensure you always use the most up to date 
version.

Note: Be sure to download the correct installer for the host system: 32-bit or 64-bit.

Note: The installation wizard installs Bartsoft and prompts the user before installing the 
USB drivers.

3.2. Setup

First ensure that no previous version of Bartsoft is currently installed on the host PC. Uninstall it 
if there is.

Run setup.exe and follow the on-screen instructions to install the application.

Note: If previous versions of Bartsoft were installed on the host PC, the associated USB 
device drivers must also be removed before the new drivers can be installed. The installer 
will prompt the removal of the older device drivers. Restart the host PC after removal of 
the old drivers and after installation of the new.

The Bartsoft installer manages the USB driver installation automatically. The application 
installer creates a copy of the USB driver files in the application’s directory (\Bartington 
Instruments\Bartsoft\USB Driver\). For the USB connection with the MS3 device to work 
properly, the two drivers that are provided in Windows ‘.inf’ format must be installed:

1. BartingtonMagSusc_device.inf (displayed in Device Manager as: ‘Magnetic Susceptibility 
Device’);



BARTINGTON INSTRUMENTS

 Page 7 of 45  OM2647/3

2. BartingtonMagSusc_driver.inf (displayed as: ‘Bartington Instruments’).

3.3. Checking USB Driver Installation

To check that the drivers are installed, open Device Manager. Ensure that the Jungo entry is 
present and is expanded. If the MS3 USB driver is installed and an MS3 device is attached to the 
PC, then at least the two entries shown in Figure 1 will be visible, without any exclamation point 
appearing in a yellow circle.

Figure 1: Windows Device Manager displaying the MS3 USB drivers

Note: If neither of the USB drivers are installed, then the user is prompted to install them 
when the MS3 is plugged in to the host PC. However, if only one of the device drivers is 
installed, Windows may not prompt for the second driver to be installed. The user must 
therefore open the Device Manager to check that both are installed.

3.4. Managing USB Drivers Manually

Installation can also be done manually through the Device Manager, which provides a utility to 
install, update or remove device drivers. Right-clicking on an unrecognised device and selecting 
the Update Driver... option from the menu (Figure 2) allows a device driver to be installed, after 
the correct driver for that device has been found.

Note: By default USB drivers for the MS3 are located at: Program Files/Bartington 
Instruments/Bartsoft/USB Driver.
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In the same way, a driver can be re-installed, if it was not installed properly in the first instance.

Figure 2: Updating driver for an unrecognised device

Note: This process must be repeated once for each MS3 driver. The order in which these 
drivers are installed is not important.

Figure 3 shows both MS3 drivers installed and working properly prior to updating.

Figure 3: Update/re-install the MS3 USB drivers

Note: The user will require ‘Administrator’ permission on the host PC to carry out these 
operations.

3.5. Installation Troubleshooting

3.5.1. Bartsoft Will Not Start

Uninstall the application and remove the USB drivers when prompted, before re-installing it. 
Ensure the correct version (32/64 bit application) is installed and that you are logged on with 
‘Administrator’ rights on the host operating system.

3.5.2. Application Starts But Cannot Detect the Connected MS3 Device

While an MS3 device is connected to the host PC, open Device Manager (as described above) and 
check that both drivers (Bartington Instruments and Magnetic Susceptibility Device) exist and 
are working properly.
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Note: Right-clicking on the driver and selecting properties will enable you to check correct 
operation: see Figure 4. If they seem to be working, check the hardware, including the 
MS3’s USB cable. Also ensure that the host PC’s USB port is functioning correctly (e.g. 
when other devices are connected).

Figure 4: Device Manager screen showing that ‘Bartington Instruments’ device is working properly.

3.5.3. Problem with the Device Driver

Uninstall the application. When prompted, ensure the device driver is also uninstalled. Make 
sure that the MS3 device is disconnected before attempting to uninstall the driver. After the 
uninstall is complete, restart the PC and then re-install the application. On completion of the 
installation, restart the PC for the second time and then connect the MS3 device. Wait a few 
seconds for the operating system to load the driver of the device. If the problem persists, contact 
Bartington Instruments Customer Services.
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4. Quick Start Guide

4.1. Introduction

This section explains the basics of the Bartsoft application and its use. It is assumed that 
Bartsoft and the USB device drivers are correctly installed and working. For installation and 
troubleshooting of the USB drivers, refer to Installation.

4.2. Running Bartsoft and Connecting to MS2/MS3 Device(s)

At start-up, Bartsoft searches automatically for any connected MS3/MS2 devices via the 
application’s default port settings. These settings assume that an MS3 device is connected to the 
host PC via a USB port.

The automatic search can only detect MS2 devices where the port setting switch (located at the 
back of the MS2 device) is set to ‘A’ mode (baud rate: 1200; data: 7 bit; stop bits: 2) or ‘B’ mode 
(baud rate: 1200; data: 8 bit; stop bits: 2). The application will not connect automatically to MS3 
devices via RS-232 (regardless of port setting) or to MS2 devices set to mode ‘C’. The status of 
the connection is indicated in the meter status window, located at the bottom right of the main 
application’s main window. The status indicator turns to green when the connection is 
successful; red when no device is detected; and yellow where a connected device is not attached 
to any sensor (Figure 5). 

Figure 5: Meter status indicator window changing from green to yellow to red.

To establish a successful connection in the cases where no automatic detection occurs, Bartsoft 
needs to be manually configured, as described below.

1. After running the application, wait for the automatic search to fail. This may take a few 
seconds. 

2. On the main application window, select Meters → Search Options... to open the Search ports 
window.

3. Make sure that the Include RS-232 check box is selected. 

Note: RS232 should be selected if using a USB to serial converter.
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4. Select one of the two available device types (Search for MS2 device or Search for MS3 
device’).

5. Select the port number from the available list of ports, where the device is connected to the 
host PC.

6. Click on the Settings button to open the Test connection window. This helps to attempt a 
quick connection to a device that is attached to a specific port on the host PC.

7. Select A, B or C from the list of Current device settings, before clicking on the Test 
connection button. The current RS-232 port setting of an MS3 device can be viewed (and 
updated) by connecting the device via USB first, and using the RS-232 Setting tab in the 
meter window.

Note: The ‘A’ setting will not work if using an MS3 device with RS-232 connection: ‘B’ or ‘C’ 
must be selected. 

8. Click OK to close the Search ports window, before starting a new search by pressing F5 on 
the keyboard or by selecting Meters → Find Meters....

Note: When Bartsoft is running, it automatically detects any MS3 that is newly connected 
via any USB port to the host PC. However, to detect devices connected via RS-232, the 
application needs to perform a scan of all of the available COM ports on the host. Initiating 
a scan refreshes any currently active connection. Therefore, if a new scan is started while 
the application is carrying out measurements, the active connection will be interrupted.

4.3. Taking Measurements

Measurements can be taken when the application detects a meter device with a sensor attached 
to it.

Note: In this case, the device status window located at the bottom right corner of the main 
window is green when a device with a sensor attached is detected. However, if there are 
multiple devices connected to the host PC, then all of those devices must be attached to a 
sensor for the status window to show as green.

Measurements can be taken in two different ways:

•	 the quick way, using the device window in which the measurements are not recorded. (For 
more information see Virtual Device Window.)

•	 according to a pre-defined program, where the records can be archived for later use.

4.3.1. Quick Measurements

To take simple measurements, while the application’s main window is open:
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1. Select Meters from the main toolbar to see a list of currently connected meters at the top.

2. Select an existing meter from this list, to open a window for that device.

3. Use the Main Interface tab containing the two Zero and Measure buttons on this window to 
take measurements.

Note: Values displayed in this window are impromptu measurements and are not saved by 
the computer.

4.3.2. Controlling and Applying Corrections to Measurements

To create an automatically controlled program for taking measurements that can be archived for 
later use, select New from the File menu to open the Report Creation Assistant and create a new 
data file, or Open to open an existing file.

Selecting New opens a wizard that lets the user configure a program for a specific device and 
sensor type.

Note: The device must be attached at the time.

This wizard lets the user set parameters that define how measurements are taken, how some 
calculations are carried out, and how the records are displayed.

•	 Report type selection: select the type of survey to be performed and the sensor being 
used. Although a sensor can be selected which does not match the one being used, some 
corrections are particular to a type of sensor. Once the appropriate survey and sensor type 
are selected, click Next to continue.

•	 Hardware & Text: select the meter to be used. It is also possible to input some comments 
about the survey, such as the name of author, etc., before clicking the Next button.

•	 Correction selection: select the drift correction and all other corrections applicable to the 
particular sensor being used. Once selected, press Next. 

Note: Dual frequency measurement for the MS2B sensor can also be selected on this 
page. 

•	 Table content: select the information to be displayed during data collection. All data are 
recorded and kept in the file, and can be visualised when reopening the file.

•	 Graph options: select the parameters of the graphic display.

•	 Position assignation: this relates to core or grid survey and lets the user set up an 
automated increment for X & Y axes on a grid or Z (depth) for a core survey. It also lets the 
user set up a gridded survey. For more details on how grid settings are set and controlled, 
see Grid and Down-Hole Options.
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•	 Measuring protocol: select the order in which measurements are to be made. If drift 
correction has been selected, the survey must finish with a blank measurement. There is 
always a blank measurement at the start, whether or not it is specified in this table. For 
example, to select 10 sample measurements between each blank measurement, enter 10 in 
the number of iterations box.

•	 Number format: select the way the data is to be displayed.

To finish configuring the report, click on Finish to close the Report Creation Assistant. (For more 
information see Report Creation Assistant)

This will open and display a new report that is ready to receive and take measurements 
according to the configured program. It displays the acquired data and lets the user save the 
records, as well as the document configuration. (For more information see Document Report)

•	 The button labelled Start Measurement carries out the entire program, unless it is 
interrupted by clicking on the Stop button.

•	 The button labelled Start Single Cycle carries out one cycle of the program, unless it is 
interrupted.

Note: When the program is interrupted before the end of a cycle is reached, if drift 
correction is enabled (and unless the last measurement was a reference) then the 
application will carry out a reference (air) measurement before it stops.

5. The Bartsoft User Interface

The Bartsoft user interface helps the user display, print and store data gathered from Bartington 
products. It includes the following groups of controls.

•	 Menus: lets the user interact with the software in order to request a particular task.

•	 Dialog bars: inform the user of tasks undertaken, scroll documents, and display shortcuts to 
the Menu.

•	 Device interface: lets the user configure for USB devices, RS-232 devices, or both.

•	 Report creation assistant: allows the creation of reports based on measurements made.

•	 Bartsoft Document (Report): for manipulating the data gathered.

5.1. Bartsoft Menus

Four different menus are available in Bartsoft:

•	 Main: available when documents are yet to be opened.
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•	 Document: becomes available when a document is open.

•	 Table: appears if you click with the mouse right button while over the Table of 
Measurements.

•	 Graph: appears if you click with the mouse right button while over the graph.

5.1.1. Main Menu

The Main menu offers the following options:

•	 File: includes file management functions as well as basic Windows-based software 
functionalities.

•	 View: lets the user choose how the Bartsoft main screen should be displayed.

•	 Meters: includes all management functions for connected instruments.

•	 RS-232: appears when RS-232 ports are available on the system, and lets the user connect 
the host computer to MS2 and MS3 devices.

•	 Help: view the application’s Help pages.

5.1.1.1. Main Meters Menu

The Meters menu offers the following commands:

•	 Find meters: starts the scan of all the host PC’s available communication ports to detect 
connected Bartington Instruments devices. Devices found will be listed and become available 
for selection in the Meters menu.

•	 Search Options: displays the configuration window to choose which port types (RS-232 
or USB) are to be included in the search for the connected devices. This window also lets 
the user configure the RS-232 port settings. (For more information see Device Search 
Configuration)

•	 Meter on port: opens the virtual device window of the meter selected. (For more information 
see Virtual Device Window)

5.1.2. Document Menu

5.1.2.1. Document Settings Menu

The Settings menu offers the following commands:

•	 Hardware Settings: selects the right measurement acquisition device. (For more information 
see Hardware & Text)
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•	 Measuring Protocol: selects how measurements will be gathered. (For more information see 
Measuring Protocol.)

•	 Table Settings: selects how measurements should be displayed within the table. (For more 
information see Table Content.)

•	 Graph Settings: selects how measurements should be displayed within the graph. (For more 
information see Graph Options.)

•	 Grid and Down-hole Settings: selects how position information is recorded with each new 
measurement. (For more information see Grid and Down-Hole Options.)

•	 Number Settings: selects format in which numbers are displayed. (For more information see 
Numbering Format)

5.1.3. Table Menu

The Table menu (Figure 6) offers the following commands:

•	 More Info: shows all information recorded for the selected measurement.

•	 Table Settings: selects how measurements should be displayed within the table. (For more 
information see Table Content.)

•	 Full Statistics: displays statistics including all recorded measurements.

•	 Number of Measurements: the number of measurements included in the statistics.

•	 Testing Period: the time period between the oldest and the most recent measurement.

•	 Maximum: the biggest corrected value recorded.

•	 Minimum: the smallest corrected value recorded

•	 Average: the average of all the corrected values recorded.

•	 Deviation: the standard deviation calculated using all the corrected value recorded.

•	 Selection Statistics: displays statistics including all selected measurements.

•	 Edit Position: edits the position of the selected measurement.

•	 Copy selected: copies the selected measurements from the table into the clipboard. These 
measurements are then available to paste in any word- or table-processing software.

•	 Cut selected: copies the selected measurements from the table into the clipboard, then 
deletes them from the table. These measurements are then available to paste in any word- 
or table-processing software.
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Figure 6: Table menu is displayed after a mouse right click on the table

5.1.4. Graph Menu

The Graph menu (Figure 7) offers the following commands:

•	 More Info: shows all information recorded for the selected measurement.

•	 Graph Settings: selects how measurements should be displayed within the graph. (For more 
information see Graph Options)

•	 Full Statistics: displays statistics including all recorded measurements.

•	 Copy Graph: copies the graph as displayed from the table into the clipboard. The graph is 
then available to paste in any word-, table- or image-processing software as a *.bmp file.

Figure 7: Menu displayed after mouse right-click on the graph
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5.2. Bartsoft Bars

Three different types of access and information bars are available in Bartsoft:

•	 Status Bar: informs the user of current actions by displaying help and software status.

•	 Toolbar: provides quick access to the menu main functions.

•	 Scrollbars: lets the user scroll the document or the table of measurement vertically and 
horizontally.

5.2.1. Status Bar

The status bar is displayed at the bottom of the Bartsoft window. To display or hide the status 
bar, use the Status Bar option of the View menu. 

•	 Information Display: the left end of the status bar describes the actions of menu items as 
the user navigates through menus.

•	 Status Display: the right end of the status bar indicates the number of compatible devices 
connected to the PC, the status of the connection to these devices (in traffic light format), and 
if any of the following keys are activated: CAP, NUM or SCRL.

The ? button provides extra information about the connection status or hints about the 
currently connected devices.

5.2.2. Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The 
toolbar provides quick mouse access to frequently used menu commands. To hide or display the 
toolbar, click Toolbar from the View menu.

5.2.3. Scrollbars

The scrollbars appear automatically at the right and bottom edges of the document or table 
of measurements if they are required to see parts of the document table that are not directly 
visible.

5.3. Bartsoft Device Interface

5.3.1. Device Search Configuration

This screen (Figure 8) lets the user choose whether Bartsoft should search for USB devices, RS-
232 devices, or both. The computer scans for the connected devices either automatically at start-
up or by the user selecting Meters→Find Meters...’ from the main menu.
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Figure 8: Device search configuration window

5.3.1.1. Include USB

Un-tick this box to exclude a search for devices connected via USB.

5.3.1.2. Include RS-232

Un-tick this box to exclude a search for devices connected via RS-232 port(s).

By default, during the scanning process the application attempts to connect to every available 
RS-232 port on the host PC and check whether it can communicate with a device.

Selecting this option lets the user specify whether to search for an MS2 device, an MS3 device or 
both. The choice made affects the communication protocol used over the RS-232 port.

Search for MS2 device

When this is selected, the application will attempt to connect to all available RS-232 ports on the 
host PC and communicate with an MS2 device. The default port settings are: baud rate: 9600, 
data: 8 bit, and stop bits: 2. This configuration is also referred to as mode ‘C’.

To target a specific port, select the port number from the available list.

To configure the selected port to use a different setting, click on the Settings button to open the 
RS-232 port configuration window (see Figure 9). This window lets the user change the default 
configuration and try to test the connection.

Note: If the user selects Search for MS2 Meters from the meter Search Options window 
while an MS3 device is connected to the host PC then Bartsoft may identify a MS3 device as 
a MS2 device. If using this option, check that no MS3 devices are attached.
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Figure 9: RS-232 port configuration window

Search for MS3 device

Select this option to limit search to MS3 devices.

Note: Whereas USB connections are automatically detected by the application while 
Bartsoft is running, if a new device is connected via RS-232 then the user needs to select 
Meters→Find Meters... from the main menu, or press the F5 key, to refresh the connection 
list.

5.3.1.3. Connection Limitations

Note: The current version of Bartsoft cannot connect to MS3 devices via RS-232 when the 
port configuration of the device is set to mode ‘A’ (data size is 7bits).

Note: It is not possible to connect to MS2 and MS3 device(s) simultaneously via RS-232 
ports. Where multiple devices are to be connected to the host PC, MS3 device(s) need to 
use USB ports.

Note: By default, the application searches for both RS-232 and USB devices. Excluding the 
search for devices connected via RS-232, or selecting a single RS-232 port as a connection 
point, can speed up the scanning time.

Note: Bartsoft will apply the selected settings for as long as it is running and will revert to 
its default when it is re-started.
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5.3.2. Virtual Device Window

This window lets the user take measurements without having to create reports.

Note: Values displayed in this window are of measurements made in the present session 
and are not saved by the computer.

5.3.2.1. MS3 Device Interface

Since MS3 meters are able to take measurements with more flexible time periods, MS3 meter 
windows are slightly different to the interface designed for MS2.

The MS3 meter interface (Figure 10) has three tabs.

•	 Main Interface: lets the user take quick measurements.

•	 Device Info: displays information about the device.

•	 RS232 Setting: lets the user view and configure the RS-232 settings of the device

Figure 10: Main interface tab for MS3 meters

Main Interface

The main display provides controls to take measurements. The window consists of a display area 
for the last measured value (or zero, if the last request was an air measurement); the status of 
the meter; and the following controls.

•	 Unit: selects the unit for the displayed value (CGS or SI).

•	 Measuring Period: selects the time period for measurements.

•	 Zero: use this button to take an air measurement. The application stores the value obtained 
as a reference which is then used in calculations, after taking a sample measurement.

•	 Measure: use this button to take a sample measurement.
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Note: It is important to keep the same time period for an air measurement and its related 
sample measurement.

Device Info

This window (Figure 11) displays information about the device:

•	 A unique serial number to identify each device (provide this number to Bartington 
Instruments if support is required).

•	 Hardware and software versions for the device.

•	 The Loader Software Version and Technician Name: these are for use by Bartington 
Instruments.

Figure 11: Device information tab for MS3 meters

RS232 Setting

This window (Figure 12) displays the device’s current port configuration. Clicking on the Refresh 
button reads and refreshes the device information, including the current port settings. To change 
the current configuration, select the required setting before clicking on the Update button.

•	 A (baud rate: 1200; data: 7 bits; end bits: 2.)

•	 B (baud rate: 1200; data: 8 bits; end bits: 2.)

•	 C (baud rate: 9600; data: 8 bits; end bits: 2.)
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Figure 12: Port configuration tab for MS3 meters

Note: Changing port configuration while an MS3 device is connected to the host PC via RS-
232 port will break Bartsoft’s connection to the device. To reconnect using Bartsoft (only 
possible for settings B & C) will require changing the application settings by using the 
Search Options’ window. (For more information, see Device Search Configuration).

5.3.2.2. MS2 device interface

This window (Figure 13) simulates the controls and display on the MS2 device. The interface 
consists of a display area for the last measured value (or zero, if the last request was an air 
measurement); the status of the meter, displayed immediately below the measured value; and 
the following controls.

•	 Unit: selects the unit for the displayed value (CGS or SI).

•	 Period: sets the time period according to the position of the hardware selector on the MS2 
device.

•	 Zero: use this button to take an air measurement. The application stores the value obtained 
as a reference to be used in calculations after taking a sample measurement.

•	 Measure: Use this button to take a sample measurement.

Note: it is important to keep the same time period for an air measurement and its related 
sample measurement.

Figure 13: Interface for MS2 meters
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5.4. Report Creation Assistant

5.4.1. Introduction

The Report Creation Assistant helps users create Bartsoft Documents using an interactive 
interface that is divided into four parts.

•	 Index: by default shows the list of settings screens and the sequence in which they are 
displayed during the report creation. However, any window can be selected by clicking on the 
index. The currently active screen’s name is displayed in bold characters.

•	 Summary: shows the main settings that will define the report.

•	 Settings windows: contains the Basic Settings or Optional Settings information screens, 
which contain information for the user about how to use the Report Creation Assistant.

•	 Navigation Buttons: 
Next displays the next settings screen within the index. 
Back displays the previous setting screen within the index. 
Cancel exits the Report Creation assistant. 
Finish creates the report in the format chosen in the Settings screen. It appears when all 
settings from the summary have been defined.

Key to Figure 14
1. Settings window 3. Settings summary
2. Navigation controls 4. Assistant index

Figure 14: Report creation assistant breakdown
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5.4.2. Basic Settings Window

The Basic Settings window shows the settings needed to create a report:

•	 Report Type Selection: the type of report is selected in this window.

•	 Hardware & Text: lets the user select the way data are entered into the report, as well as 
providing extra information about the report in text format.

•	 Correction Selection: allows selection of the correction algorithm and any correction 
automation.

5.4.2.1. Report Type Selection

This screen (Figure 15) lets the user choose the type of report and sensor that is going to be 
used.

Figure 15: Report type settings

Four report types are available:

•	 Individual sample study: used for studying individual samples. By default, no graph will be 
displayed.

•	 Core and down-hole survey: used for studying cores or samples that are positioned linearly. 
A 2D graph that shows measurements in function of linear position or sample index will be 
displayed by default.

•	 Surface survey: used for studying a surface that is mapped onto a grid. A grid that shows 
measurements as a function of (X, Y) position co-ordinates will be displayed by default.
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•	 Drift Check: for making sure that the sensor environment is sufficiently quiet magnetically 
for taking measurements and/or making sure that the sensor is behaving consistently.

Note: While configuring a new report, the user must select a sensor type or the Drift 
Check option before proceeding to configure any other setting.

Note: The application creates a default program of measurements, according to the 
selected report type. Therefore, changing report type will erase any program input by the 
user.

5.4.2.2. Hardware & Text

This screen lets the user select a device from a list of currently connected devices.

A device within the list can be selected by a left mouse click.

Click on the Refresh button to start scanning all the PC’s communication ports for connected 
devices.

Note: This screen remains in view-only mode (i.e. the above actions are disabled) if the 
application is busy acquiring data from one or more device(s).

5.4.2.3. Correction Selection

To measure the permeability of a sample to a high accuracy, the raw value obtained from the 
sensor needs to be corrected. The correction algorithm takes three major factors into account: 
temperature drift, the sample and sensor’s compatibility, and the susceptibility of the sample’s 
container.

Temperature Drift

Check the Apply Drift Correction box to select temperature drift correction. To take into account 
the effect of the temperature on the measurements, the permeability of the air is measured 
once before and once after the permeability of the sample itself. As temperature variation can 
be considered linear over a short period of time, the error in susceptibility measurements can 
be deduced and corrected, using the measured discrepancy between the first and the last air 
measurements.

Sample/Sensor Association

All Bartington Instruments sensors are designed to measure volumetric susceptibility 
accurately. However, the volume of a sample may not always be the same as the volume 
expected by the sensor. This difference must be accounted for. Bartsoft provides a list of 
correction algorithms depending on the type of sensor being used.

•	 ‘Volume specific correction’: when the container in which the sample is stored has a volume 
different from the volume of the provided calibration sample.



BARTINGTON INSTRUMENTS

 Page 26 of 45  OM2647/3

•	 ‘Height specific correction’: when all samples are stored in cylindrical containers of the same 
diameter but not all containers are filled to the same height.

•	 ‘Mass specific correction’: provided if if the volumetric susceptibility must be related to the 
density of the sample. All samples must be stored in containers of equal volume for this 
algorithm to be accurate. 

•	 ‘Diameter specific correction’: when sample cores have varying diameters.

How to select the required correction type

The program wizard provides a list of correction types for specific sensors to let Bartsoft carry 
out the relevant corrective calculations. The available correction types depend on the selected 
sensor type. Figure 16 shows the available correction types for each sensor. (Bartsoft does not 
currently offer correction for other sensors.)

Correction Type MS2B MS2G MS2C

Volume √ √ ---

Mass √ --- ---

Height --- √ ---

Diameter --- --- √

Figure 16: Correction algorithms table

Available configurations for different correction types are as follows:

Correction Type Options Instructions

Volume Use same volume for all 
samples

Tick this box when all 
containers used have the 
same volume, different 
to the calibration sample 
provided.

Untick the box to ensure 
that Bartsoft prompts the 
user to provide the volume 
of the sample’s container 
after each measurement is 
taken.

Volume of the sample in ml Enter the container’s 
volume, if the container 
used has a different volume 
to the reference volume.
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Mass Empty container mass in g Enter the container’s mass. 
(The default value provided 
in the text box is the weight 
of the standard 10ml plastic 
sample pot.)

Volume of the sample in ml The same as above, where 
the selected correction type 
is volume specific.

Height Use same height for all 
vials

Tick this box when all 
containers used have the 
same height, different to 
the height of the calibration 
sample provided.

Untick the box to ensure 
that the application prompts 
the user to provide the 
height of the sample’s 
container after each 
measurement is taken.

Sample fill height in mm Enter the height of the 
sample within the container.

Diameter Sensor’s diameter in mm Enter the sensor’s diameter 
in millimetres, if it is 
different from the provided 
default value.

Diameter of the core in mm Enter the diameter of the 
core to study in this box.

5.4.3. Optional Settings Window

The optional settings window includes settings that have been initialised with default values. 
These can be edited to adapt to the user’s particular needs.

•	 Table Contents: selects how measurements should be displayed within the table.

•	 Graph options: selects how measurements should be displayed within the graph.

•	 Position assignation: selects the way positions (X,Y,Z) are automatically assigned to each 
measurement.

•	 Measuring Protocol: selects how measurements will be acquired.

•	 Number format: chooses a numbering notation: Scientific, Engineering or Fixed Exponent.
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•	 Grid and Down-hole Options: sets options for down-hole or core measurements, or surface 
mapping.

5.4.3.1. Table Content

This screen lets the user choose which fields (columns) are to be visible within the table of 
measurements.

If the width of the total number of columns to be displayed exceeds the width of the display area 
then a horizontal scrollbar will appear at the bottom of the table. However, only the displayed 
information will be printed if/when the document is printed.

•	 Identifier: a string of characters used to name and recognise a measurement.

•	 Date & Time: the date and the time at which the measurement was stored in memory. Time 
is used as part of the Drift correction (if enabled).

•	 Position: information about where the measurement was taken. It is expressed in metres 
and displayed in X and Y components.

•	 Latitude/Longitude: geographical information about where the measurement was taken.

Note: This information is applicable to grid reports and is only provided by Bartsoft running 
on a handheld mobile Windows CE platform with a connected GPS system.

•	 Depth: usually used for measurements taken from a core or within a borehole. Refers to the 
depth/point, where the measurement was taken and is expressed as the ‘Z’ component of the 
position.

•	 Corrected Value: the resulted value after applying corrections to the raw value. It includes all 
pre-set corrections. (For more information see Correction Selection.)

•	 Raw Value: the value as it has been measured, before any correction is applied to it.

•	 Measuring Unit: the unit in which the raw and corrected values are expressed.

•	 Correction information: the type of correction, the corrective factor and the corrective offset 
that have been used to calculate the corrected value for the measurement.

•	 Container information: information about any container used in the measurement protocol. 
This is used to correct the raw value of the measurement.

•	 Sample information: information about the sample measured. This is used to correct the 
raw value of the measurement.

•	 Device information: includes the hardware used to take the measurement.

•	 Entry type: information about how the measurement was received. It can be one of:
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•	 an automatically acquired measurement from a Bartington product connected to the 
PC (default)

•	 a manual entry of a measurement with limited information about time and no 
correction.

•	 Comment: where the user can add any extra information about the measurement as text.

5.4.3.2. Graph Options

This screen (Figure 17) lets the user choose the type of graph, 2D or grid, that is to be displayed 
in the report, as well as the colour scheme applied to it. Only one graph is available in any one 
report.

•	 The 2D graph shows corrected measurements (Y axis) versus sample order, position (X or 
Y) or depth (X axis). Select this type of graph by checking the View 2D Graph in the report 
check-box.

•	 The Grid shows corrected measurement (cell colour) versus position X (X axis) and position 
Y (Y axis). If a coordinate has no related measurement attached to it then it is filled with 
the graph background colour. The pitch of the grid is calculated in function of the minimum 
coordinate spacing between two consecutive positions (X and Y independently). Select this 
type of graph by checking the View Grid in the report check-box.

Note: If neither of the two check-boxes are selected then no graph will be displayed. This 
will leave more space for the table to be displayed.

Figure 17: Graph settings
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Colour scheme

The graph colours can be selected using the drop-down lists.

Note: The colour controls are only enabled if a graph type is selected.

5.4.3.3. Grid and Down-Hole Options

This screen lets the user set an automatic depth increment for down-hole or core 
measurements, or alternatively set up grid-based surveys for surface mapping.

Down-hole (borehole) settings

Down-hole settings (Figure 18) are available when the selected report type is Core and down-
hole survey (see Figure 15). Tick the Automatic Depth Inputs to enable the related controls:

Figure 18: Down-hole settings

•	 Initial depth in meters: the depth at which the first measurement is taken.

•	 Depth increment in meters: the amount in metres that is added to the depth after each 
measurement is taken.

•	 Max. depth in meters: the depth (set by the user) at which the program stops taking 
measurements.

Note: Bartsoft will always take an extra measurement if the max. depth has not been 
reached exactly using the specified increments. Therefore, if the max. depth is not exactly 
divisible by the depth increment, the final measurement taken will exceed the max. depth.

Grid settings

Grid settings (Figure 19) become available when the selected report type is Surface survey (see 
Figure 15) and Automatic Grid Position Inputs is also ticked.

Figure 19: Grid settings
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The available settings are as follows:

•	 Start position on the grid: the X and Y position on the grid, where the respective minimum 
values will be started.

•	 Position increment in metres: value automatically added to the current X/Y values to 
calculate the next measurement position on the grid. For example the first measurement has 
the position equal to the values in Start position on the grid; the second measurement’s 
position is deduced by incrementing the X value of the current position on the grid by the X 
value defined in Position increment in metres (Figure 20).

Figure 20: Automatic position increment

•	 Number of measurements: the number of measurements on each axis is calculated as: (grid 
size / position increment) + 1 (the 1 is added to account for the measurement on the point 
of origin). Total number of measurements on a grid can be calculated by multiplying the X 
and Y fields of the Number of measurements. The values entered in these fields can only be 
positive whole numbers.

•	 Size of the grid: calculated by multiplying the position-increment value by the number of 
measurements and deducting one from the result. If the user changes the X and Y size 
values then the application automatically updates the Number of measurements to keep the 
equation valid.

5.4.3.4. Measuring Protocol

The measuring protocol defines how the measurements are carried out during the automatic 
measurement program.

Note: A protocol consists of one or more cycles. A typical cycle includes a list of different 
measurement types, where non-blank measurements may also be repeated more than 
once.
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Interface components

The interface (Figure 21) includes:

•	 Controls to help the user create and add measurements to the list of command/task(s):

1. Command: list box to select the measurement type.

2. Meas. period: list box to select the measurement’s time period. A custom value can be 
entered by selecting the Manual Entry from the list and then entering a value followed 
by one of ‘s’, ‘m’ or ‘h’ (for seconds, minutes or hours). The value entered can contain a 
floating point (e.g. ‘6.5m’ for 6.5 minutes).

3. Nb of iterations: edit box to enter the number of times to repeat the measurement (not 
available for blank measurements).

4. Add button, to add the selected command to the list of tasks.

•	 Number of cycles: a box that contains the number of times the list of measurements should 
be repeated.

•	 List of Commands in each Cycle: a table that displays the current list of tasks as part of a 
cycle.

•	 Remove / Remove all buttons: used to remove one (highlighted) item or all of the items from 
the list.

Figure 21: An example protocol of measurements

In the example in Figure 21, the application will take a blank measurement, followed by two 
sample measurements, repeating the cycle 10 times.



BARTINGTON INSTRUMENTS

 Page 33 of 45  OM2647/3

Note: As magnetic susceptibility is derived from the measurement of relative permeability 
(permeability of sample/permeability of vacuum, which is approximated to the permeability 
of air measured by the meter during the zero or blank measurement step), cycles need to 
start with a blank measurement. Therefore, if a cycle does not start with a blank, it will be 
added automatically by the application.

Note: The setup wizard establishes whether a Drift Correction is required as part of a 
susceptibility measurement correction algorithm. If it is then each cycle must start and 
end with a blank measurement. If/when the user interrupts a cycle before its natural end, 
the user will be prompted for a final blank measurement. If Drift Correction is selected, 
the application prompts the user to end the cycle with a blank measurement.

Note: When frequency dependency measurements are required (using the MS2B) and 
Drift Correction is selected, the program must start with a blank measurement. The 
program must include two blank measurements inserted at the point where the frequency 
type changes (e.g. from LF to HF or vice-versa). The program must also end with a blank 
measurement.

Note: When frequency dependency measurements are required (using the MS2B) and Drift 
Correction is not selected, the program needs only one blank measurement when the 
frequency type changes. In this case there is also no need for the program to end with a 
blank measurement.

5.4.3.5. Numbering Format

The acquired measurements can be displayed in one of three numbering formats (Figure 22).

Figure 22: Numbering format settings
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 The format can be selected during the initial report creation steps, or while viewing a report by 
selecting Settings from the Report menu.

•	 Scientific: Numbers are displayed with only 1 digit before the decimal point.

•	 Engineering: Numbers are displayed with exponents consisting of a power of 3.

•	 Fixed exponent: The exponent is fixed by editing the default value in the box.

The number of digits after the decimal point can be selected in the Digits after decimal point 
drop-down box.

Unit selection

In the Physical characteristic drop-down box, select the type of physical characteristic to 
measure (e.g. Magnetic Susc. when using MS2 or MS3 meters).

In the Unit drop-down box, select the unit in which the characteristic should be displayed (e.g. 
‘SI’ or ‘CGS’ for magnetic susceptibility).
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5.5. Bartsoft Document (Report)

Bartsoft Document, or Report (Figure 23), is created using the Report Creation Assistant and can 
be divided into six parts.

1. Report Title: the name of the file that you are viewing. It is followed by an asterisk (*) if it has 
not been saved since the last modification.

2. Data Processing Information: shows all information used to correct raw data.

3. Table of Measurements: displays all the acquired measurements. The table also lets the 
user edit, remove and add measurements to the document.

4. Measurements Graph: displays all the acquired measurements in a two-dimensional graph 
or grid.

5. Minimise/Maximise Controls: allow the user to hide unwanted information, in order to leave 
more space for important information.

6. File Information: shows all information about the creation of the file. The Note field can be 
edited by double-clicking it with the left button of the mouse.

Key to Figure 23
1. Report Title  4. Measurements Graph
2. Data Processing Information  5. Minimise/Maximise Controls
3. Table of Measurements  6. File Information

Figure 23: Bartsoft Document (Report) breakdown
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5.5.1. Minimise/Maximise Controls

The six parts of the report fall into three main sections that can be minimised or maximised:

•	 Report information (Report Title, File Information, Data Processing Information)

•	 Table of Measurements

•	 Graph.

Each section can be hidden or shown using the Minimise/Maximise boxes in the left margin of 
the report. Each box contains either a ‘+’ or a ‘-’ sign depending on the current state of a section. 
To show a section, click on a ‘+’ box; to hide a section, click on a ‘-’ box.

5.5.2 Table of Measurements

The table of measurements (Figure 24) displays the acquired measurements in a list format. 
Users can edit some fields or remove the selected record(s) of measurements.

Key to Figure 24

1. Column titles 5. Selected measurements
2. Scrollbars 6. Pointed measurement
3. Table buttons 7. Table menu
4. Progress bars 8. Selected title (sorting)

Figure 24: Table of measurements breakdown

There are three parts to the table (Figure 24):

•	 column titles

•	 records of measurements

•	 control table buttons.
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5.5.2.1. Column Titles

These form the first line of a table. Each title (displayed in bold characters) describes what the 
column contains.

Records in the table can be sorted in ascending or descending order, by selecting a title using the 
left mouse button. A selected title is displayed as highlighted. To change the sort order, the same 
column title should simply be selected for the second time.

Note: Clicking on the same column title for the third time changes the sorting order to its 
default format (displayed as it was initially acquired).

5.5.2.2. Measurements

Each line contains all information about a measurement that the users chooses to make visible. 
To change what information is visible, use the table menu.

If the width of a given display is insufficient for the number of columns chosen to be displayed, 
then the table’s horizontal scrollbar will enable the user to view hidden columns.

To select a measurement, use the left mouse button or the up/down arrow keys on the keyboard. 
The PgUp and PgDn keys show the first and the last record on the table, respectively.

To highlight or clear highlighted record(s):

•	 use the left mouse button + control key for individual records

•	 use the Shift key + left mouse button for a group of records

•	 press the Home and End key to highlight/clear all records respectively.

The Identifier, Comment and Position information of a measurement can be edited by double-
clicking with the left mouse button on the text to edit.

More actions are available by clicking the right mouse button over a record, which displays the 
table menu attached to the selected measurement.

5.5.2.3. Repeating a Measurement

When the application prompts the user to take the next measurement, it gives the option 
of repeating the previous measurement. When a blank (air) measurement is repeated, the 
application replaces the previous blank. This means that multiple blanks are not recorded 
within the program database. However, if a sample measurement is repeated, a separate record 
for each repeated measurement is created. Multiple measurements of the same sample are 
expected to be resolved (see Resolving Repeated Measurements).

Note: Dual frequency measurements cannot be repeated (this applies to MS2B sensors, 
where ‘Frequency dependent calculation’ is selected).
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Figure 25 shows the application prompt before taking a blank measurement. However, the user 
can select ‘Repeat last measurement’ to repeat the previous step. Note that the prompt gives the 
type and measured value of the previous measurement, to help in deciding whether to repeat a 
measurement.

Figure 25: Repeating previous measurements

Figure 26 shows that a measurement has been repeated multiple times. To help identify 
repeated measurements, the background colour is different and the names of repeated 
measurements are appended with ‘*xx’, where ‘xx’ is an auto-incremented number. (In this case: 
surf1_0003*01, surf1_0003*02 etc.) When prompted to take the next measurement, if the user 
leaves the Repeat last measurement box un-checked then the application moves to the next 
measurement. When the user finishes repeating measurements, the application prompts that 
repeated items need to be resolved, before continuing with the rest of the program.

Figure 26: Merging multiple measurements
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To postpone resolving repeated measurements, the user can select I will resolve repeats at the 
end of the program, when prompted. Alternatively, it is possible to save a report with repeated 
measurements and resolve them later.

5.5.2.4. Resolving Repeated Measurements

This can be done before taking the next measurement, or at the end of the program of 
measurements.

To resolve or manage repeated measurements, the user can:

•	 remove the highest or lowest value

•	 simply select and delete any repeated item, as with any measurement

•	 merge multiple measurements into one, by calculating their mean value (Figure 26).

To resolve one group of repeated measurements, right click on any individual measurement 
within the group to display a pop-up menu. To resolve multiple groups of repeats, select at 
least one measurement from each group, before using the pop-up menu. Alternatively, select 
Edit→Manage repeated measures from the main menu.

5.5.2.5. Table Buttons

There are five buttons at the bottom of the table. Their action, visibility and ‘enable’ state are 
dependent on the state of the table.

•	 The Start Measurement button at the far left has multiple functions. Its main objective is to 
gather measurements.

•	 While there is no data acquisition device selected, the button is labelled Select Meter 
and opens the Hardware Settings window, to let the user choose a working device. (For 
more information see Hardware & Text.)

•	 If a device has been selected, the button is labelled Start measuring and will start the 
data acquisition process.

•	 If Manual Entry has been selected for entering measurements, the button is labelled 
Enter Measurement and will display the Manual Entry Interface that lets the user 
enter measurements manually.

•	 During data gathering the Start button is labelled Measuring or Zeroing. Two Progress 
Bars will appear below the button. The top one shows the advancement of the full 
protocol. The bottom one shows the advancement of the current cycle.

•	 The Start Single Cycle button at the right of Start Measurement will start a single cycle of 
the measurement protocol. (For more information see Measuring Protocol)
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•	 The Stop button appears at the right of Start Measurement when the data gathering process 
is in progress and lets the user interrupt the process.

•	 The Delete Selected button appears at the bottom right of the Table of Measurements if 
there is at least one measurement selected in the table. Clicking this button will remove all 
selected measurements. Alternatively, the ‘delete’ key on the keyboard has the same effect.

•	 The Delete all button appears at the bottom right of the Table of Measurements if there is 
at least one measurement in the table. Clicking this button will remove all records from the 
table.

Note: Any record removed from the table is also removed from the application’s database. 
However, if the open document is associated with a file on the host PC, then the file is not 
affected until and unless the document is saved after removing the record.

5.5.3. Graphs

The graphs give an overview of all stored measurements. Two types of graph can be selected 
using the Graph Settings window in the Settings menu: 2D Graph and Grid Graph.

5.5.3.1. 2D Graph

Depending on how measurements are currently sorted, this graph (Figure 27) shows values 
(vertical axis) in relation to position or sample index (horizontal axis). (For more information 
about sorting see Column Titles)

Key to Figure 27
1. Axis titles
2. View range
3. Pointed measurement information

Figure 27: 2D graph breakdown
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5.5.3.2. Grid Graph

This graph shows values (colour gradient) in function of grid position (X on horizontal axis, Y on 
vertical axis).

Key to Figure 28
1. Value range  3. View range
2. Axis titles  4. Pointed measurement information

Figure 28: Grid graph breakdown

5.5.3.3. Graph Controls

The following actions are available while the mouse pointer is over the Graph area.

•	 Highlighting and Selecting. Right clicking the mouse on a graph element selects the related 
record within the measurement table. If the Control key is held down at the same time, the 
record on the table is highlighted.

•	 Menu. Clicking on the graph area with the right mouse button displays the Graph Menu.

•	 Zoom. To zoom into the graph, drag the mouse pointer while holding down the right mouse 
button. As the right mouse button is released, the area within the created rectangle is 
magnified. Repeat this action to increase the magnification level. To return to the normal 
graph display, double click the left mouse button on the graph area.

•	 Scrolling. While in the zoom mode, the graph can be scrolled by holding down the left mouse 
button and dragging it.

Keyboard commands described in Measurements in the Table of Measurements section above 
are also available (see Measurements).
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6. Troubleshooting

In the event you are experiencing issues with the software and that this manual does not enable 
you to solve the issue, please email service@bartington.com, or telephone the Bartington 
Instruments service team on +44 (0)1993 706565. 

mailto:service%40bartington.com?subject=
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Appendix A: Correction Algorithm

Abbreviation Description

cmeas Volume susceptibility of the sample measured (dimensionless)

cvol Volume susceptibility of the sample (dimensionless) 

cmass Mass susceptibility of the sample (m3/kg) 

ccont Volume susceptibility of the container (dimensionless) 

rsamp Density of the sample (kg/m3) 

mtot Total mass of the sample with the container (kg)

mcont Mass of the container (kg) 

vsamp Volume of the sample inside container 

vref Volume of calibration sample used as a reference (m3) 

hsamp Height reached by the sample inside container

href Maximum height within the container 

dsamp Diameter of the sample core

dref Diameter of the coil opening (sensor opening + enclosure thickness) 

The volume specific correction algorithm is:

cvol = (cmeas x (vref / v samp )) - ccont

The height specific correction algorithm is:

cvol = (cmeas x (1 – 0.00002077)

– 0.0042414 x (href - hsamp )

+ 0.0028426 x (href - hsamp )
2

– 0.0003460 x (href - hsamp )
3

+0.0000136 x (href - hsamp )
4 )) - ccont

The diameter specific correction algorithm is:

χvol = (χmeas / (3.45 x ( dsamp / dref )
3 )) - χcont
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The mass specific correction algorithm is:

χmass = χ vol / r samp

Where

rsamp = (mtot - mcont ) / vsamp

Appendix B: Conversions from cgs to SI

For volume susceptibility: 
From SI (dimensionless) to electromagnetic units cgs (dimensionless): 
cvol (SI) = c vol (cgs) x (4π)

For mass susceptibility: 
From SI (m3 / kg) to electromagnetic units cgs (cm3 / g): 
cmass (SI) = c mass (cgs) /1000 x (4π)
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